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1. Introduction 
CycloSearch makes it possible to click in a Cyclorama and have CycloSearch display 
characteristics of the objects located at or near the position clicked at, such as addresses of 
houses.  
 
CycloSearch requires that Cyclomedia's CycloScope is installed. 
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2. Installation 
Installation of ARIS CycloSearch is accomplished by executing the automatic installer, 
ArisCycloSearch.exe. You need to be logged in as a user with administrator privileges to run 
the installer.  
 
Before you can run ARIS CycloSearch you should have Cyclomedia's CycloScope is 
installed. We refer to CycloMedia for that installation. 
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3. Registration 
The distributed version of ARIS CycloSearch is a fully functional trial version. This means it 
can be used for evaluation purposes for 5 days. After this period, ARIS CycloSearch is locked 
until a valid license key is entered. 
 
While in evaluation mode, each time you start and exit CycloSearch, and when clicking in a 
Cyclorama, a reminder message is shown. 
 

 
 
Pressing the Buy Now! button takes you to our online store, where you can order this product. 
Note that you will need the hardware fingerprint of the computer where you want to install the 
tool, shown in the dialog below (appears when you press Enter Key). After you complete your 
purchase, a personal registration key is sent to you by email. Please store this key in a safe 
place. 
Pressing the Enter Key button presents you with the following dialog, where you must enter 
your name and the registration key. 
 

 
 
Once you have entered a valid registration key, press OK. This key is stored on your pc. The 
reminder message will not be shown anymore. 
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4. Version History 

4.1 Version 1.0.1 
Version 1.0.1 is the first release of ARIS CycloSearch. 
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5. Program description 

5.1 Starting a CycloSearch project  

5.1.1 Requirements 

In order to be able to work with CycloSearch the user requires the following: 
• CycloMedia's CycloScope. We refer to CycloMedia details about the installation of 

CycloScope. 
• CycloSearch. 
• Files to be displayed in the map. At this moment this can be shape files and/or .tiff 

files. Two special shape files are required: 
o A shape file with the positions of the Cycloramas. 
o A shape file with result data, which can be displayed in the map. 

• A collection of Cycloramas stored in a directory. The directory is set in CycloSearch, 
enabling CycloSearch to load the Cycloramas. 

5.1.2 Starting CycloSearch for the first time 

When starting CycloSearch for the first time an empty screen is displayed: 
 

 
 
First project settings should be defined, by selecting the Tools\Settings menu option: 
 

 
 
The settings window is displayed. This window has different pages, as is described in section 
5.4. In the settings window you should: 

• First define the layers involved in the project, by browsing these layers in the 'Map' 
page (chapter 5.4.1). The layers where the checkbox 'Show' is checked will appear in 
the map. 

• Select the 'Cyclorama layer' and 'Image field' in the 'Cyclorama' page (chapter 5.4.2). 
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The Cyclorama layer must be included as one of the layers in the 'Map' page. 
The 'Cyclorama layer' contains filenames for the Cyclorama taken (in the 'Image 
field'). If these filenames are just filenames, without directories, the directory where 
the Cycloramas are located must be defined in the 'Image directory' field, otherwise 
the Cycloramas cannot be located.  
After these parameters have been set it is possible to view Cycloramas by clicking in 
the map of the main window, thus opening the nearest Cyclorama. This can be done 
when the Settings window is still open. 

• To see any results in the results table of the Cyclorama window three things must be 
performed in the Settings window: 
• Define the 'Search' characteristics in the 'Search' page (chapter 5.4.3). A search 

layer must be selected, and default values for search distance, horizontal search 
angle and vertical search area may be overwritten. 
The best value for search distance depends upon the situation, and is usually 
determined by trying a few values and common sense. In general you only want 
to find objects displayed in the Cyclorama. For example, in densely build areas 
the search distance is probably only about 50 meters or less; any further 
buildings are usually blocked from the Cyclorama by closer buildings. In more 
open areas this is not the case, and the search distance can often be much 
larger. The best maximum search angle is also established by trying a few values 
and common sense. 

• Define result columns of information to be displayed about the matching objects 
(chapter 5.4.4). When at least one column is defined information can be 
displayed.  

• Define the 'Graphics' displayed on the Map in the main window. Default settings 
are provided, and 'Cyclorama viewing direction', 'Found objects' and the 'Selected 
object' are shown by default. But these settings may of course be overruled in the 
'Graphics' page (chapter 5.4.5). 

 
After these settings are completed it is possible to click in the map in the Main window, thus 
opening the Cyclorama window, which displays a Cyclorama. After clicking in the Cyclorama 
matching objects are displayed in the results table in the Cyclorama window, and as graphics 
in the map of the Main window.   
 
When CycloSearch is exited the settings are automatically written to the initialization file. 
When CycloSearch is restarted it reads this initialization file, as described in the next chapter 
(5.1.3). 

5.1.3 Restarting CycloSearch and CycloSearch initialization file 

When CycloSearch is restarted it will always look for the initialization file. If the initialization 
file was moved or removed by the user an empty screen is displayed, and settings must be 
defined as explained in chapter 5.1.1. However normally the initialization file will be located, 
so that layers and other settings will appear again as they were before CycloSearch was shut 
down.  
 
The default initialization file is located at the user's 'documents and settings' directory, sub-
directory: 'Application Data\ARIS\CycloSearch'. It is possible to save the 'CycloSearch.ini' 
project, by moving or copying that file. That project can be re-opened by selecting the 
File\Open menu option and opening that file. Note that changes to project settings will then be 
written to that project file. 
 
It is possible to start CycloSearch with the path of an initialization file as its only parameter. In 
that case CycloSearch will start from that initialization file. 
 
Any CycloSearch initialization file has the extension .ini. It is a simple text file, which defines 
all the settings displayed in the Settings window (chapter 5.4) and some other parameters.  

5.2 CycloSearch Main Window 
When starting CycloSearch the CycloSearch main window is displayed: 
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The CycloSearch main window contains three components: 

• The CycloSearch main menu.  
• The CycloSearch toolbar.  
• A map display.   

 
When starting CycloSearch for the very first time no map is displayed. Select the 
Tools/Settings menu option to define which layers should be displayed in the map, the 
location where Cyclorama's are located, the type of objects searched for, etc. See chapter 5.4 
and 5.1.1 for details. 

5.2.1 CycloSearch main menu 

The CycloSearch main window has the following menus: 
 
The File menu: 
 

 
 
The File menu contains the following options: 

• Open. Allows the user to browse to another project. When another project file is 
selected the CycloSearch project settings and layers displayed in the map will be set 
according to the contents of the initialization file for that project. See chapter 5.1.3 for 
more details. 

• Print. Prints the map displayed on the screen. CycloSearch will ask for a title, which is 
displayed in the print. 

• Exit. Exits from CycloSearch. 
 
The View menu: 
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The View menu contains the following options: 

• Return to previous extent. When zooming in or out or panning, a different portion (or 
extent) of the map is displayed. When the 'Return to previous extent' menu action is 
executed the map will display the portion that was displayed before the last zooming 
or panning action. 

• Go to Next Extent. After selecting this menu option or pressing this toolbar button the 
portion (or extent) of the map displayed is reset to the extent displayed before the last 
'Return to previous extent' action was performed. 

• Zoom to Full Extent. After pressing this button the map extent will be such that the full 
extent of every layer in the project is displayed on the map display. 

 
The Tools menu: 
 

 
 
The Tools menu contains the following option: 

• Settings. Starts the Settings window, which enables the user to define some 
important settings, such as the layers shown in the map, location of Cyclorama's, 
items searched for when clicking in the map, etc. The settings window is described in 
detail in section 5.4, Settings. 

    
The Help menu: 
 

 
 
The Help menu contains the following options: 

• Help. Displays this help text. 
• About. Displays general information about the CycloSearch application. 

5.2.2 CycloSearch toolbar buttons 

The CycloSearch main window contains two types of toolbar buttons: 
• Action buttons. Something happens immediately after such a button is pressed. An 

equivalent of every action button also appears as a menu item in the CycloSearch 
main window menu.  

• State buttons. Nothing happens immediately after pressing the button. However 
pressing the button may have consequences for later actions, such as clicking or 
moving the mouse in the map. After being pressed a state button is set (displaying it 
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in a pressed down state), until another state button is pressed. 
 
The toolbar contains the following action buttons: 

 Zoom to previous extent. Displays the map as shown before the last zooming or 
panning action. 

 Zoom to next extent. Displays the map as shown before the last 'zoom to previous' 
action. 

 Show full extent. Makes the map extent such that every layer is completely 
displayed in the map. 

 
The toolbar contains the following state buttons: 

 Zoom in. After pressing this button the user can zoom in to a rectangle drawn in the 
map or zoom in by a factor 2 after clicking in the map.  

 Zoom out. After pressing this button and clicking somewhere in the map the map will 
zoom out by a factor 2, thus displaying a larger portion of the map. The center of the 
display will be where the user clicked in the map. 

 Pan. After pressing this button and moving the mouse in the map with the left 
mouse-button down, the portion of the map displayed will be moved according to the 
movement of the mouse. 

 Show information. After clicking on an object in the map with the left-mouse button a 
screen opens displaying all information that is stored about that object in the object's 
shape file. 

 Show Cyclorama. Click somewhere in the map with the left-mouse button. The 
Cyclorama Window will display the Cyclorama taken at the point closest to where 
the user clicked. The Cyclorama is pointing towards where the user clicked in the 
map. See chapter 5.3 about the Cyclorama Window. 
When the Show Cyclorama button is disabled not all required settings have been 
assigned. See chapter 5.4 for details. 

5.2.3 CycloSearch main window map display 

The map displayed in the CycloSearch Main Window displays the layers as defined in the 
project settings (see chapter 5.4). The project settings also define how these layers are 
displayed. 
 
When clicking in the map certain actions may be performed, depending upon which state 
button is currently set. See chapter 5.2.2, CycloSearch toolbar buttons for this. 

5.3 Cyclorama Window  
Setting the 'Show Cyclorama' button ( ) in the CycloSearch Main Window (by pressing it, 
see chapter 5.2.2 for details) and then clicking in the map will display the Cyclorama, taken 
closest to the point clicked in the map. The Cyclorama will point towards where the user 
clicked in the map.  
 
This requires Cyclomedia's CycloScope to be installed.  
 
For example the following Cyclorama window may be shown: 
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The Cyclorama Window consists of: 

• A toolbar.  
• The Cyclorama. 
• The table of results. 
• Information about the Cyclorama itself (the viewing direction). 
• A 'Close' button. Pressing this button closes the Cyclorama window. 

5.3.1 Cyclorama window toolbar 

The Cyclorama window toolbar contains four buttons. All these buttons are 'state buttons' 
(see chapter 5.2.2 for an explanation). Pressing one of these buttons won’t have any 
immediate effect, except for the button being displayed in a pressed down state.  
 
However after clicking or moving the mouse cursor somewhere in the Cyclorama the following 
things happen: 

 Show information. When clicking somewhere in the Cyclorama with the left mouse 
button, CycloSearch will search and list the objects most likely pointed at in the 
Cyclorama. Information about these 'possibly matching'' objects is displayed in the 
Table of Results. See chapter 5.3.2 for more details. 

 Rotate Cyclorama. When clicking in the Cyclorama with the mouse, and keeping the 
left mouse button pressed down, the Cyclorama will rotate horizontally and/or 
vertically, so that the Cyclorama will point in a different direction. The direction and 
distance that the mouse position is away from the center of the Cyclorama 
determines the direction and speed of rotation in the Cyclorama display. The 
horizontal direction in which the Cyclorama is pointing can be displayed as the 
viewing direction line in the Cyclorama main window map (chapter 5.4.5). 

 Zoom in. After pressing this button and pointing the mouse in the Cyclorama, the 
Cyclorama will zoom in (be enlarged) to where the mouse cursor was pointed in the 
Cyclorama. 

 Zoom out. After pressing this button and pointing the mouse in the Cyclorama, the 
Cyclorama will zoom out (show a larger extent), positioning the center of the 
Cyclorama to where the mouse cursor was clicked in the Cyclorama. 

5.3.2 Table of results 

The table of results is a table located below the Cyclorama in the Cyclorama window.  
 
When clicking in the Cyclorama with the 'Show information' toolbar button ( ) pressed down, 
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CycloSearch displays information about all matching objects in the table of results. These 
search results can be any type of objects (for example addresses). That type is defined by the 
search layer, which is set in the 'Search' page of the project settings (see chapter 5.4.3). 
 

 
 
The columns displayed in the table and their captions are defined in the 'Results' page of 
project settings (see chapter 5.4.4). Each row represents a possible matching object. These 
search results are sorted according to the sorting criterion defined in the 'Results' page of the 
project settings. 

5.3.3 Information about the Cyclorama 

The bottom of the Cyclorama window describes the viewing direction of the Cyclorama. This 
is the compass direction of the center of the Cyclorama. The viewing direction can also be 
displayed in the map in the Cyclorama main window as the viewing direction line (see chapter 
5.4.5). 

5.4 Settings 
The Settings dialog is displayed when the Tools/Settings menu option is selected in the 
CycloSearch main window (chapter 5.2.1). The Settings dialog contains the following pages: 

• Map. 
• Cyclorama. 
• Search. 
• Results. 
• Graphics. 

 
Changing any of these settings is immediately visualized in the CycloSearch main window 
map (described in chapter 5.2.3) and/or Cyclorama results table (described in chapter 5.3.2). 
 
The Cyclorama settings (chapter 5.4.2) must be set before a Cyclorama can be displayed.  

5.4.1 Map 

The map is displayed in the CycloSearch main window (5.2.3). The layers displayed in this 
map, and how these layers are displayed, is defined in the 'Map' page of the Settings window: 
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The Map page consists of a table, containing the layers, and buttons to add, remove and 
move these layers. 
 
A layer is displayed in the map when the checkbox in the 'Show' column is checked.  
 
The buttons perform the following actions: 

 
Adds one ore more layers to the table. A file browser dialog is started, enabling the 
user to select the layers to be added to the table. Fastkey: Insert. 

 
Removes all selected layers from the table. These layers cannot be displayed in the 
map anymore, but also these layers cannot be used for settings anymore, such as 
the Cyclorama layer (chapter 5.4.2) and/or the Search layer (chapter 5.4.3). 
Fastkey: Delete. 

 
Moves all selected layers one position up in the table. These layers are also moved 
up in the map shown in the Cyclorama main window (see 5.2.3). Fastkey: Control + 
Up arrow. 

 
Moves all selected layers one position down in the table. These layers are also 
moved down in the map shown in the Cyclorama main window. Fastkey: Control + 
Down arrow. 

 
Layers can be lines, polygons, points (markers) or graphics (.tiff files). CycloSearch 
establishes automatically which kind of layer it is dealing with. The Symbology box enables 
the user to view and/or alter the following features of the layer display in the Cyclorama main 
window map: 

• Color of line, color of edge and/or filling of polygon, color of marker filling. 
• Type of line (e.g. solid, dotted, etc), marker (e.g. circle, diamond, etc) or polygon 

filling (e.g. solid, diagonal, etc). 
• Size of marker or width of line. 
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5.4.2 Cyclorama 

 
 
The ‘Cyclorama’ page defines the following parameters: 

• Cyclorama layer. This is the layer that contains the positions where the Cycloramas 
were taken.  

• Image field. This is a field of the Cyclorama layer that contains the image id or the full 
path of the images.  

• Image directory. This is the directory where the images are stored in case the image 
field contains a relative path or no path. If the image field contains full paths to the 
images, this field may be left empty. 

 
Note that the Cyclorama layer must be defined in the map page (chapter 5.4.1). Removing 
this layer from the layer list in the map page wipes the contents of the Cyclorama layer field. 
Also the Image field is a field from the Cyclorama layer. Altering or wiping the Cyclorama 
layer wipes the Image field. 

5.4.3 Search 

When the user clicks in the Cyclorama of the Cyclorama window any possible matching 
objects are displayed in the results table of that window (see 5.3.2). These matching objects 
should not deviate too far from where the user clicked, in horizontal and vertical directions. 
That means that any matching objects should be located inside the horizontal and possibly 
also inside the vertical search sector. 
 
Information about horizontal and vertical search sectors is displayed and can be altered in the 
Search page: 
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In the ‘Search’ section the following parameters are set: 

• Search layer. The layer that contains the (point) objects to search for. The layer must 
be present in the current map. 

• Search distance. The maximum distance that possible objects are from the point 
where the Cyclorama was taken.  

• Horizontal search angle. The search for possible matching objects takes place in a 
sector (pie) at search distance from the point where the Cyclorama was taken. This is 
the horizontal search area. The horizontal search angle (displayed in degrees) is the 
angle between the outer edges of the horizontal search area. The middle of this 
sector is where the user clicked in the Cyclorama. 

 
It is possible to use height information in the search calculations: 

• Use height. Check if you want to use height information. 
• Height field. The field from the search layer that contains the Z-values of the objects.  
• Vertical search angle. The angle between the edges of the vertical search sector, 

which is searched for any possible matching objects. This means that objects located 
between half this angle above and half this angle below where the user clicked in the 
Cyclorama can be included in the search results. 

 
When the height field or vertical search angle is not filled in it is not possible to include height 
information for the search calculations, and thus height is not taken into account for locating 
the matching search objects. 
 
Changing or wiping the search layer, or removing it in the 'Map' page (chapter 5.4.1) will have 
consequences for fields that come from this layer: 

• The height field is wiped, so height information is not included in the search 
calculations. 

• Search layer result column definitions ( , see chapter 5.4.4 about result definitions) 
are wiped from the displayed columns. 
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5.4.4 Results 

 
 
In the 'Results' page of the Settings window the user can define: 

• Columns displayed in the 'Table of results' in the Cyclorama window (see chapter 
5.3.2). 

• Item by which the results must be sorted. 
 

The results column values can originate from: 
• The search layer ( ). The value of selected fields in the shape file can be displayed 

in the search results. For example in the window shown above 'ADRESSE' and 'Z' 
values come from the shape file and are displayed for every matching object. 

• Calculated values ( ). These are values calculated for the search results, such as 
distance from where the Cyclorama was taken, deviation from the horizontal/vertical 
search line, x, y and z-position of matching objects. 

 
Result columns have a 'name' and a 'display text'. The 'name' is either the field name from the 
search layer, or the item that can be selected from the calculated values. The display text is 
the text shown above the column in the results table in the Cyclorama window (see chapter 
5.3.2). If no display text is provided the 'name' value is shown above the column instead. 
 
The buttons in the search result columns table perform the following actions: 

 
Edit the result column definition. Another layer, calculation result or display text can 
be defined through the 'Define Result Column Characteristics' window, which is 
explained below. Fastkey: Enter. 

 
Adds another results column definition. The definition must be set through the 
'Define Result Column Characteristics' window. Fastkey: Insert. 

 
Removes all selected result columns from the table. Fastkey: Delete. 

 
Moves all selected result columns up in the table. Fastkey: Control + Up arrow. 

 
Moves all selected result columns down in the table. Fastkey: Control + Down arrow. 

 

When the edit ( ) of add ( ) button is pressed the 'Define Result Column 
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Characteristics' window is shown: 
 

 
 
Through the radio buttons the source of the displayed values can be selected. In the name 
field the shape file field or calculated value can be selected. The display text is an optional 
text field and represents the caption above the column in the Search results table in the 
Cyclorama window.  
 
Search results are represented in the Results table in the Cyclorama window (chapter 5.3.2). 
These results are sorted according to the criterion set in the 'Sort result on' combobox. One of 
the calculated values (except for the index) must be selected here. Most likely this will be the 
deviation from the horizontal and/or vertical search angles, but it is also possible to sort the 
results on horizontal, vertical or total distance from the horizontal or vertical search lines (that 
run through the centers of the search areas), the distance from where the Cyclorama was 
taken, or the x, y or coordinate. 

5.4.5 Graphics 

When clicking in the Cyclorama in the Cyclorama window (chapter 5.3) matching objects are 
displayed in the results table. It is also possible to display any of the following features in the 
map of the Cyclorama main window (chapter 5.15.2.3): 

• The Cyclorama viewing direction. This is a line pointing in the direction to where the 
(middle of the) Cyclorama is pointing. When defined this line is always shown when 
the Cyclorama window is opened. 

• The horizontal search line. 
• The horizontal search area. 
• The search objects that were found. 

 
Which features are displayed and how these features are displayed is defined in the 
'Graphics' page of the Settings window: 
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The 'Graphics' page describes a number of graphics types. By checking or unchecking the 
'Show' checkbox that graphic can be showed or hidden in the map of the CycloSearch main 
window. When selecting any of these graphics types the Symbology box of that type is 
displayed, enabling the user to view and/or alter the characteristics of this graphics type. For 
example, in the window displayed the 'Cyclorama viewing direction' is selected. In the 
Symbology box the characteristics of the 'Cyclorama viewing direction' are displayed and can 
be altered. Below the Symbology box a picture displays what the graphic looks like in the 
map. The graphic is shown in color, on a black and white background.  
 
Two remarks: 

• For altering the line color click on the colored square below the text. 
• The color in the picture below the Symbology box is usually the default color of the 

graphic and not the color that is currently set for that graphic in the Symbology box. 
 
The Cyclorama viewing direction is the direction to where the center of the Cyclorama is 
pointing:  
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The Cyclorama viewing direction is shown when the Cyclorama window is open and its 'Show' 
checkbox is checked. 
 
Here the Cyclorama viewing direction is displayed as a thick black line. It originates from 
where the Cyclorama was taken ( ) and runs due west from there. The length of the line is 
the maximum search distance defined in the project settings (Search settings, paragraph 
5.4.3). 
 
The search line, search area, found objects and selected object are displayed only after the 
user clicked in the Cyclorama in the Cyclorama window (paragraph 5.2.3), provided their 
respective 'Show' checkboxes were checked. For example, after clicking in the Cyclorama, 
the map in the main window (chapter 5.2.3) may look as follows: 
 

 
 
In this map the search area is displayed as the hatched pie with thin orange edges. The 
characteristics of the pie's edge lines and filling can be set in the Symbology box of the 
'Search area' graphic. The orange arc is drawn at the maximum search distance from the 
Cyclorama point ( ) and is thus the limit of the horizontal search area. The maximum search 
distance was of course defined in the Search page (see chapter 5.4.3)  
 
The 'Search line' runs through the middle of the 'Search area', and is displayed here as a 
thicker orange line. The color and thickness of this line are set in the Symbology box of the 
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Search line. 
 
In this example the objects searched for are addresses. Four addresses were located within 
the (horizontal) search area, and are thus displayed in the Results table of the Cyclorama 
window (as described in chapter 5.3.2): 
 

 
 
The matching addresses are sorted by the deviation from the search line, which was set as 
sorting criterion in the Results page (chapter 5.4.4). The first address (which is closest to the 
search line) is selected. 
 
The matching addresses are also highlighted in the map display of the main window: 
 

 
 
The selected address is displayed as a red circle, as it was defined in the Symbology box for 
the 'selected object'. The other matching addresses are displayed as green circles, as defined 
in the Symbology box for the 'found objects'. 
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5.5 Tips and tricks for CycloSearch users 

5.5.1 Search distance 

The best value for search distance defined in the 'Search' page of the Settings window 
(paragraph 5.4.3) depends upon the situation, and is usually determined by trying a few 
values and common sense. In general you only want to find objects displayed in the 
Cyclorama. For example, in densely build areas the search distance is probably only about 50 
meters or less; any further buildings are usually blocked from the Cyclorama by closer 
buildings. In more open areas this is not the case, and the search distance can often be much 
larger. The best maximum search angle is also established by trying a few values and 
common sense. 

5.5.2 Including map layers more than once 

It is possible to include a layer more than once in the map layers list (paragraph 5.4.1). For 
example in the following map: 
 

 
 
The Cyclorama layer was included twice in the map layers list with different Symbology, so 
that the Cyclorama positions are displayed as a read circle with a brown diamond inside it . 
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Appendix. License Agreement
ARIS Software License Agreement for ARIS CycloSearch
------------------------------------------------------------------
This is a license agreement and not an agreement for sale. This license agreement
(hereinafter referred to as AGREEMENT) is between the end user (hereinafter referred
to as LICENSEE) and ARIS b.v., The Netherlands (hereinafter referred to as ARIS), and
gives the LICENSEE certain limited rights to use the proprietary ARIS software
CycloSearch, examples, on-line and hardcopy documentation and updates (if applicable),
hereinafter referred to as PRODUCT. All rights not specifically granted in this
AGREEMENT are reserved to ARIS.

Ownership and grant of license
-------------------------------------------------
ARIS and its third party licensor(s) retain exclusive rights, title, and ownership of
the copy of the PRODUCT licensed under this AGREEMENT and hereby grant to LICENSEE a
personal, non-exclusive, non-transferable license to use the PRODUCT based on the
terms and conditions of this AGREEMENT. From the date of receipt, the LICENSEE shall
agree to make reasonable efforts to protect the PRODUCT from unauthorized use,
reproduction, distribution, or publication.

Copyright
---------------
The PRODUCT is owned by ARIS and partly by its third party licensor(s) and is
protected by Dutch copyright laws and subject to international laws, treaties, and/or
conventions.
The LICENSEE agrees not to export the PRODUCT into a country that does not have
copyright laws that will protect ARIS's proprietary rights.

Permitted uses
-----------------------
The LICENSEE may use the number of copies of the PRODUCT for which license fees have
been paid on computer system(s) and/or specific computer network(s) for the LICENSEE's
own internal use.

The LICENSEE may install the number of copies of the PRODUCT for which license or
update fees have been paid onto permanent storage device(s) on computer system(s)
and/or specific computer network(s).

The LICENSEE may make one (1) copy of the PRODUCT for archival purposes only, during
the term of this AGREEMENT, unless the right to make additional copies has been
granted by ARIS to the LICENSEE in writing.

The LICENSEE may use parts of the documentation in other documents for LICENSEE's own
internal use only with the purpose of using or encouraging to use the PRODUCT.

Uses not permitted
------------------------------
The LICENSEE shall not sell, rent, lease, assign, timeshare, or transfer, in whole or
in part, or provide unlicensed third parties access to prior or present versions of
the PRODUCT, any updates, or the LICENSEE's rights under this AGREEMENT.

The LICENSEE shall not reverse, engineer, decompile, or disassemble the PRODUCT, or
make any attempt to alter the license number and other license information shown in
the about box.

The LICENSEE shall not remove or obscure any ARIS copyright or trademark notices.

The LICENSEE shall not make additional copies of the PRODUCT beyond what is laid down
in the "permitted uses" section of this AGREEMENT.

Term
--------
The license granted by this AGREEMENT shall commence upon LICENSEE's receipt of the
PRODUCT and shall continue until such time as:
· the LICENSEE elects to discontinue the use of the PRODUCT;
· ARIS terminates the agreement due to the LICENSEE's material breach of this
AGREEMENT.

Upon termination of this AGREEMENT in either instance, LICENSEE shall return to ARIS
the PRODUCT and any whole or partial copies in any form. The parties hereby agree that
all provisions operating to protect the rights of ARIS shall remain in force, should
breach occur.
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Limited Warranty
--------------------------
ARIS warrants that the media upon which the PRODUCT is provided will be free from
defects in materials and workmanship under normal use and service for a period of
ninety (90) days from the date of receipt.

Except for the above express limited warranties, the PRODUCT is provided "as is",
without warranty of any kind, either express or implied, including, but not limited
to, the implied warranty of merchantability and fitness for a particular purpose.

Exclusive Remedy and Limitation of Liability
--------------------------------------------------------------------
During the warranty period, ARIS's entire liability and the LICENSEE's exclusive
remedy shall be the return of the license fee paid for the PRODUCT that does not meet
ARIS's limited warranty and that is returned to ARIS or its dealers with a copy of the
LICENSEE's proof of payment.

ARIS shall not be liable for indirect, special, incidental, or consequential damages
related to LICENSEE's use of the PRODUCT, even if ARIS is advised of the possibility
of such damage.

Waivers
-------------
No failure or delay by ARIS in enforcing any right or remedy under this AGREEMENT
shall be construed as a waiver of any future or other exercise of such right or remedy
by ARIS.

Order of Precedence
---------------------------------

Any conflict and/or inconsistency between the terms of this AGREEMENT and any purchase
order, or other terms shall be resolved in favor of the terms expressed in this
AGREEMENT, subject to Dutch law, unless agreed otherwise.

Governing Law
------------------------
This AGREEMENT is governed by the laws of the Netherlands without references to
conflict of laws principles.

Entire Agreement
---------------------------
The parties agree that this constitutes the sole and entire agreement of the parties
as to the matter set forth herein and supersedes any previous agreements,
understandings, and arrangements between the parties relating hereto and is effective,
valid, and binding upon the parties.

ARIS is a registered trademark, the Netherlands.
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